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2018-2019 ANNUAL REPORT 

University of Washington Student 

Chapter  

of the Earthquake Engineering Research Institute 

Report Date: June 20, 2019 

This report summarizes the membership and activities conducted by the University of Washington Student 

Chapter of the Earthquake Engineering Research Institute during the 2018-2019 academic year. 

MISSION & GOALS 

The Earthquake Engineering Research Institute at UW Student Chapter (EERI at UW) was founded in 2019 under 

the following mission:  

 

 

 

Though founded within the Department of Civil and Environmental Engineering, current leadership envisions the 

chapter as a hub for learning and fellowship within other departments across campus and external 

organizations. In doing so, the chapter will connect its members with resources to support earthquake 

engineering research and teaching activities, open career pathways, and serve the public. Working towards 

this vision was a goal of the organization this year and will continue to be a goal.  

 

MEMBERSHIP 

The University of Washington Student Chapter had a total of 13 members in 2018-2019. Four of the five officers 

are from the Civil & Environmental Engineering Department and the last officer is from the Public Policy and 

Governance Department. All members are currently from the Civil & Environmental Engineering Department 

however, there was occasional attendance at meeting from people outside the Civil & Environmental 

Engineering Department.  

 

To prepare future leaders in earthquake engineering, sciences, and policy through 

interdisciplinary dialogue, professional engagement, and public outreach.  
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OFFICERS 

The Board consisted of the following members: 

Role Name 
EERI Member 

Number 
Email Student Status 

President Sarah Wichman 20222 wichman@uw.edu 
Graduate 

student 

Vice President Andrew Makdisi 18880 ajmakdisi@gmail.com 
Graduate 

student 

Secretary Kamal Ahmed 18957 kamal2@uw.edu 
Graduate 

student 

Treasurer Alex Baird - abaird2@uw.edu 
Graduate 

student 

Outreach 

Coordinator 
Karen Izumoto - kizumoto@uw.edu 

Graduate 

student 

 

FACULTY & INDUSTRYADVISORS 

 

Role Name 
EERI Member 

Number 
Email Affiliation 

Faculty Advisor Paolo Calvi 18165 pmc85@uw.edu 
University of 

Washington 

Industry Advisor Kyle Steuck 12031 ksteuck@degenkolb.com 
Degenkolb 

Engineers 

For the 2018-2019 academic year, the EERI at UW student chapter worked in collaboration with the Washington 

Regional EERI Chapter.  

MEMBERS 

A complete list of members is shown below. 

Name 
EERI Member 

Number 
Email Student Status 

Chi-Pu Lin 29951 cpl7@uw.edu 
Graduate 

student 

Tianye Yang 18949 tianyy3@uw.edu 
Graduate 

student 

Sarah Bergquist - Sd30@uw.edu 
Graduate 

student 

Gloria de Zamacona - gedz@uw.edu 
Graduate 

student 

Ken Sullivan - kpsulliv@uw.edu 
Graduate 

student 

Stephan Ahn - sahn1995@uw.edu 
Graduate 

student 

Chris Pike - cpk3@uw.edu 
Graduate 

student 

Araj Shrestha - araj@uw.edu 
Undergraduate 

student 
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BUDGET & FINANCIALS 

The EERI at UW student chapter has an account with the University. The chapter does not collect membership 

dues from members. The budget is used to support food costs for our seminars.  

CHAPTER ACTIVITIES 

The EERI at UW student chapter did not hold regular chapter meetings for the 2018-2019 academic year but 

has coordinated several activities on-campus. The following sections describe each activity in detail.  

2018-2019 ACADEMIC YEAR KICK OFF MEETING 

The 2018-2019 academic year kick off meeting happened on October 10, 2018. A presentation about the EERI 

student chapter was given to graduate and undergraduate students to encourage them to join the Chapter. A 

total of 27 students attended the meeting. In addition, the new officers were selected.  

 

SEMINARS 

alex grant, November 26, 2018 

Research Civil Engineer, USGS 

On November 26, 2018 alex grant from the U.S. Geological Survey gave a presentation to EERI at UW members 

titled, “Reconnaissance of the September 5, M6.6 Tomakomai Earthquake.” He spoke about his recent 

reconnaissance work from the Tomakomai Earthquake which occurred in September of 2018. He spoke about 

the over 3,000 landslides and lateral spreads that were triggered as a result of the earthquake. He discussed the 

GEER reconnaissance of the earthquake, the observed ground failure and structural damage, techniques for 

data collection used in the field, and the factors leading to the observed patterns of landslides and 

liquefaction. About 25 student attended the seminar.  
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Dr. Sean Ahdi, April 22, 2019 

Lecturer, UCLA Earth, Planetary, and Space Sciences 

Dr. Sean Ahdi gave a seminar to the EERI at UW student chapter titled, “Seismic Site Characterization and its 

Implementation in Ground Motion Modeling.” During his presentation, Dr. Sean Ahdi outlined the Next-

Generation Attenuation-Subduction (NGA_Sub) project, a major multi-national effort to develop ground 

motion models (GMMs) for subduction zones around the world, including a focus on work performed in the 

Cascadia and Alaska subduction zones. During the seminar, he talked how an emphasis is place on the 

determination of seismic site parameters used in GMMs, particularly the time-averaged shear-wave velocity in 

the upper 30 meters of the Earth’s crust and basin depth terms, and their inclusion as site parameters in a 

database of earthquake recording stations for use in GMM development. Finally, he discussed the major multi-

institutional effort to compile a national database of time-averaged shear-wave velocity profiles that could 

utilize data from NGA-Sub and other major research and industry projects from across the U.S. About 25 people 

including undergraduate students, graduate students, post-doc researchers, and professors from both the Civil 

and Environmental Engineering Department and outside the department attended this presentation.  

THE WILLIAM B. JOYNER LECTURE 

Dr. Ellen Rathje, April 1, 2019 

Professor, University of Texas at Austin 

The EERI at UW student chapter co-sponsored The William B. Joyner Lecture with the University of Washington 

Civil and Environmental Engineering Department and the EERI Washington Chapter. A few members of the EERI 

at UW student chapter meet with Dr. Ellen Rathji in the afternoon for a small discussion on our research interests 

and topics as well as our use of Design Safe in our work. The small discussion was shortly followed by a lecture 

from Dr. Ellen Rathje. Dr. Ellen Rathje’s presentation was titled “Seismic Landslide Assessments: Bridging the Gap 

between Engineers and Earth Scientists.” The presentation described the integration of performance-based 

engineering concepts into regional-scale seismic landslide assessments. She first introduced the basic PBE 

framework for seismic landslides and listed the modifications needed before it can be applied at a regional 

level. Next, she discussed the approach for applying a seismic landslide hazard map and use of seismic 

landslide inventories to validate regional landslide assessments. She also explained the advancements in 

developing seismic landslide inventories and the use of remote sensing techniques.  
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FRIEDMAN FAMILY VISITING PROFESSIONAL VISIT DAY 

Jay Wilson, March 4, 2019 

Resilience Coordinator, Clackamas County Disaster Management 

Jay Wilson visited the EERI at UW student chapter on March 4, 2019. In the morning, student chapter officers 

met with Jay Wilson for breakfast and after we gave him a tour of campus and More Hall (the Civil and 

Environmental Engineering building). After, Jay Wilson met with some of the Civil and Environmental Engineering 

faculty members for small discussions, followed by a lunch with EERI student chapter members. After lunch, Jay 

met with more University of Washington faculty before giving his seminar presentation to the EERI at UW student 

chapter.  

Jay Wilson’s presentation was titled, “Pursuing Community Disaster Resilience: Challenges and Opportunities” to 

a group of approximately 25 students, professors, and industry professionals. He provided numerous vivid 

examples from his experience in earthquake reconnaissance in Italy and Japan. His presentation framed the 

concept and purpose of community disaster resilience from the perspective of local emergency management 

leadership. How can national and state resilience goals be implemented locally? How is resilience translated 

into action for decisions and investments? How can communities facing high seismic risk better align with 

climate resilience initiatives? In his lecture Jay Wilson addressed this topics by examining the context of the 2013 

Oregon Resilience Plan and the 2015 Community Resilience Planning Guide by the National Institute of Science 

and Technology and how resilience is being demonstrated in the Portland metro region. Jay Wilson also 

referenced examples from his multiple EERI Learning from Earthquake trips to the Tohoku tsunami zone and 

central Italy.  

 

EDUCATIONAL OUTREACH: ENGINEERING DISCOVERY DAYS  

The EERI at UW student chapter hosted an earthquake engineering exhibit entitled “Make It and Shake It: Your 

Buildings, Our Earthquakes” at the University of Washington’s annual Engineering Discovery Days (April 25 and 

26, 2019). The chapter has formally participated since 2018 when the exhibit was adapted from a prior, long-

running exhibit developed by students at the University of Washington. In its current form, the exhibit introduces 

K-12 students to the local seismology of Wester Washington and how structural engineers design earthquake-

resistant buildings. These concepts are delivered interactively using a small shaking table and wooden building 

models constructed by the students. Each building is subjected to ground motions recorded in the Northridge 
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(crustal) and Nissqually (intraslab) earthquakes, as well as a simulated M9 Cascadia Subduction Zone 

earthquake provided by the University of Washington’s “M9 Project.” 

 

      

 

ELECTION & ELECTION RESULTS 

An election for officers for the 2019-2020 academic year will be held at the beginning of the next academic 

year.  

LIST OF ATTACHMENTS  

Included at the end of this report are various attachments to supplement the information included above.  A 

list of the attachments is included below: 

 Item 1, Meeting Announcements 

 Item 2, Engineering Discovery Days Handout for Participants 

 Item 3, Engineering Discovery Days Handout for Volunteers 

 



2018-2019 Academic Year Kick Off Meeting Announcement  

 

Earthquake Engineering Research Institute 

University of Washington Student Chapter Meeting 

 
Date: Wednesday, October 10 
Time: 4:30pm - 5:30pm 
Location: MOR 218 
 
The Earthquake Engineering Research Institute (EERI) University of Washington 
Student Chapter is excited to announce our first meeting for this year. This meeting will 
discuss what the EERI student chapter is and our goals for this coming year and the 
future years. Graduate students, undergraduate students, Civil Engineering majors, and 
non Civil Engineering majors are welcome! See attached flyer for more details.   
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Earthquake Engineering Research Institute 

University of Washington Student Chapter Meeting 

 

Date: Monday, November 26 

Time: 5:00-7:00pm 

Location: MOR 110 

 

Join the EERI at UW student chapter for our November monthly meeting. The meeting will 

feature a presentation from alex grant, a recent UW geotechnical engineering graduate who is 

now working for the USGS. He will be speaking about his recent reconnaissance work from the 

Tomakomai Earthquake which occurred in September of 2018. All are encouraged to attend – 

you do not need to be a member of EERI. More information about the presentation can be found 

below.  

 

Reconnaissance of the September 5, M6.6 Tomakomai Earthquake 

alex grant, USGS 

 

The Sept 5 M6.6 Tomakomai earthquake triggered over 3,300 landslides and lateral spreads 

covering a total area of ~67km2. Landslides and liquefaction from this earthquake caused 

widespread damages in rural communities of southern Hokkaido and within the city of Sapporo. 

In this seminar, I will discuss the GEER reconnaissance of the Tomakomai earthquake, observed 

ground failure and structural damage, techniques for data collection (UAV, lidar) used in the 

field, and factors leading to the observed patterns of landslides and liquefaction. 

 

Bio: alex got his Ph.D. in 2017 from the University of Washington where he studied coseismic 

landslide hazard and risk in Lebanon, New Zealand, Japan, and the Pacific Northwest of N. 

America. alex received his BSCE from Tufts University in 2013 and a MSE in 2014 from the 

University of Washington in Geotechnical Engineering. alex joined the USGS in 2018 to 

research earthquake-induced ground failures, and is actively working on projects in the Pacific 

Northwest and California.  
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Earthquake Engineering Research Institute 
University of Washington Student Chapter Meeting 
 
Date: Monday, April 22nd, 2019 
Time: 4:30pm 
Location: TBD 
 
Speaker: Dr. Sean Ahdi, Lecturer, UCLA Earth, Planetary, and Space Sciences 
 
 
Title: Seismic Site Characterization and its Implementation in Ground Motion Modeling 
 
 
Abstract: 
 
Infrastructure projects routinely require analyses that provide estimates of expected earthquake 
ground motions at a given site of interest. Geotechnical earthquake engineers and engineering 
seismologists commonly use empirical ground motion models (GMMs), which incorporate 
information regarding the earthquake source, wave propagation path, and local site conditions, to 
compute average estimates of shaking intensities and their associated uncertainties. This talk 
outlines the Next-Generation Attenuation-Subduction (NGA-Sub) project, a major multi-national 
effort to develop GMMs for subduction zones around the world, including a focus on work 
performed in the Cascadia and Alaska subduction zones. An emphasis is placed on the 
determination of seismic site parameters used in GMMs, particularly the time-averaged shear-
wave velocity (VS) in the upper 30 meters of the Earth’s crust (VS30) and basin depth terms, and 
their inclusion as site parameters in a database of earthquake recording stations for use in GMM 
development. Finally, a major multi-institutional effort to compile a national database of VS profiles 
that will utilize data from NGA-Sub and other major research and industry projects from across 
the U.S. is described. 
 
Bio: 
  
Dr. Sean Ahdi is an Associate at Exponent, Inc., a multi-disciplinary engineering and scientific 
consulting firm, working in the Civil Engineering Practice in Los Angeles, CA, as a geotechnical 
engineer and engineering geologist. Prior to joining Exponent, Dr. Ahdi earned B.S., M.S., and 
Ph.D. degrees in Civil (Geotechnical) Engineering and a B.S. in Geology/Engineering Geology, 
all at UCLA, and serves as a Lecturer in the Department of Earth, Planetary, and Space Sciences 
at UCLA. He is the past Chair of the Student Leadership Council of the Geo-Institute of ASCE at 
the national level, and is the Secretary of the Joint International Strong Motion Committee 
between the International Association of Earthquake Engineering (IAEE) and Consortium of 
Strong Motion Observation Stations (COSMOS). He has co-authored a guidelines document for 
the California Department of Transportation regarding the use of geophysical methods in 
application to geotechnical engineering projects, and is a member of a multi-national working 
group headed by COSMOS to develop a guidelines document for the application of noninvasive 
geophysical methods for seismic site characterization. Dr. Ahdi’s main research interests lie in an 
intersection of disciplines, including geotechnical earthquake engineering, engineering geology, 
seismology, and geophysics. His Ph.D. dissertation work focused on developing improved 
frameworks for seismic site characterization data at various spatial resolutions. 
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Please join us for the EERI at UW Friedman 
Family Visiting Professionals Program Lecture 

 
Pursuing Community Disaster Resilience: Challenges and 
Opportunities 

Featuring Jay Wilson, Clackamas County Resilience Coordinator 
 

RESCHEDULED TIME:  Monday, March 4, 5:30pm 
Alder Hall Auditorium 
University of Washington 

  

 

 
 
 
 
 
 
 

Free and open to the public. No RSVP required. Social Hour to follow at Big Time Brewing.  
 

 

For questions or more information, 
contact the EERI at UW student chapter 

at EERIatUW@uw.edu 
 

 

This EERI Professional Lecture will frame the concept and purpose of 
community disaster resilience from the perspective of local emergency 
management leadership. How can national and state resilience goals be 
implemented locally? How is resilience translated into action for decisions 
and investments? How can communities facing high seismic risk better 
align with climate resilience initiatives? In this lecture Jay will broadly 
address these topics by examining the context of the 2013 Oregon 
Resilience Plan and the 2015 Community Resilience Planning Guide by 
the National Institute of Science and Technology and how resilience is 
being demonstrated in the Portland metro region. Jay will 
also reference examples from his multiple EERI Learning From 
Earthquake trips to the Tohoku tsunami zone and central Italy.  

Jay Wilson is the Clackamas County Resilience Coordinator with the Department of Disaster 
Management and spearheads the County's efforts to reduce risks and assess hazards including flood, 
earthquake, wildfire, volcano, and climate change impacts. Mr. Wilson is the past-Chair (2014-17) of 
the Oregon Seismic Safety Policy Advisory Commission (OSSPAC) and previously worked for 
Oregon Emergency Management and as a Mitigation Reservist with FEMA Regions IX and X.  



Make It and Shake It: Your Buildings, Our
Earthquakes

Andrew Sen
Earthquake Engineering Research Institute

Department of Civil and Environmental Engineering
University of Washington

April 25 and 26, 2019



Instructions

You are tasked with designing and building a 1- or 2-story house in
Seattle. You must design your building to resist 3 different earthquakes
capable of being produced by nearby faults.

1. Before building your house, think about the materials you have and
come up with a design.

2. If you think you need more materials, ask a volunteer!

3. Leave space on your roof for concrete blocks, which will represent
your building’s weight.

4. When you are ready to shake your house, tell a volunteer!



Tips

I How will your building resist the earthquake? Most buildings look like
one of the following:

Moment Frame
(Frame Only)

Braced Frame Shear Wall

I Not enough materials? Try mixing the different building types above.

I Test your building before you shake it by holding the base firm while
pushing on the roof.



Nearby Faults

Image from the Pacific Northwest Seismic Network

The Pacific Northwest is threatened by three primary source types:

1. Crustal: shallow and potentially very close to Seattle

2. Intraslab: deeper and along the subducting slab

3. Subduction: megathrust; most powerful but somewhat distant



Northridge (Mw6.7)

Crustal Earthquake
Recorded ground motion obtained from NGA-West2
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The Northridge Earthquake occurred on January 17, 1994 and caused an
estimated $13-40 billion worth of damage in the Los Angeles area.



Nisqually (Mw6.8)

Intraslab Earthquake
Recorded ground motion obtained from IRIS
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The Nisqually Earthquake occurred on February 28, 2001 and caused
damage across the Pacific NW, including the Alaskan Way Viaduct and

numerous brick buildings in Seattle.



Cascadia (Mw9)

Subduction Earthquake
Simulated ground motion obtained from UW’s M9 project
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Earthquakes from the Cascadia Subduction Zone may cause ground
shaking for up to 2 minutes. Scientific evidence suggests its most recent

rupture was around 1700.



Shake-Table Operation

1. ST Configurator
1.1 From the desktop, load ST Configurator if it is not already open.
1.2 Select File → Open and open ShakeTable.st.
1.3 Click Connect.
1.4 Select Tools → Q Programmer.

2. Q Programmer
2.1 Select File → Open Program and open Northridge.qpr from the

/Desktop/Step Driver/2017 folder.
2.2 In the Program box on the left, select Download Program.
2.3 Ensure the table is centered on the rails. If it is not centered,

disable the motor and center the table using your hand. Then,
enable the motor.

2.4 In the Program box on the left, select Execute Program.
2.5 Repeat Steps 2.1 through 2.4 for Nisqually.qpr and Cascadia.qpr.
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EERI Exhibit:  

Make It and Shake It: Your Buildings, Our Earthquakes  

Design and construct a building, then test its earthquake resistance on our shake table. Can your 

building survive Seattle’s Big One? 

 

Summary of Exhibit:  

In small groups, students will build 1- or 2-strory structures out of pegboard, wooden dowels, 

and plywood. When building is finished, they will bring their structure to the EERI portable 

shake table and they will get to test their structure under 3 different earthquakes.  

 

Volunteer Roles:  

From past experience, things will work best if we have two people at the shake table: one person 

controlling the shake table, and one person helping students install and remove their structures 

from the table. The other two volunteers can help kids build their structures.  

 

In the google drive folder, there are slides which I will print and display around our exhibit. 

These include the instructions and some information about the earthquakes. The final side has 

instructions for operating the shake table.  

 

Below is some information on construction and testing. What you'll need to be doing will be 

obvious once you see the exhibit, but this is here as a reference. When your volunteer shift is 

complete, make sure the incoming volunteers know what they're doing. 

 

Construction 

The kids will build 1- or 2-story structures (depending on material availability and interest). We 

have enough materials to have 3-4 buildings under construction and testing at a time. The basic 

materials are: 

 Thick pegboard base plates 

 Thin pegboard floors/roofs 

 Wooden dowel rod columns or braces 

 Thin plywood walls 

 Wooden connector pieces (joints) 

The joints and rods are color-coded to facilitate construction. 

 

Testing 

When a building is finished, direct the kids to the shake table. Ask the kids which direction they 

want their building to shake in. Slide the base plate in between the two steel angles attached to 

the shake table. You may need to adjust the angles since the base plates vary a bit. 

 

Add an appropriate amount of weight to the building using the concrete blocks. If a building 

looks pretty marginal (e.g., just a moment frame), do not overload it. If the building does not 

collapse and there are not other groups waiting, you can try adding more weight and retesting. If 

they build a 2-story building, consider adding weight at both stories. 



Engineering Discovery Days Handout for Volunteers 

 

2 

 

 

Have the kids step back from the table to a safe distance. Run the ground motions using the 

procedure specified in the attached slides. I'll leave a copy of this at the exhibit. There are 3 

different motions representing the 3 primary source mechanisms that comprise Seattle's seismic 

hazard: crustal, intraslab, and subduction. Note that they are scaled in intensity and time so, for 

instance, the subduction-zone earthquake will not last 2 minutes. If a building looks particularly 

bad, it's a good idea for the shake-table operator to be ready to catch/restrain the structure/weight 

in case of collapse (as said before, try not overload to that scenario). Falling concrete blocks are 

a safety hazard and could damage the shake table. 

 

 

 

 


